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4.0 Secure Meeting Error Messages
This document describes the error messages that Secure Meeting administrators, meeting creators, and meeting attendees may see while setting up 
and using Secure Meeting. It includes each error’s message text, unique ID, the circumstances under which the error occurs, and the recommended 
methods for handling the error. This document also includes information about troubleshooting Secure Meeting and accessing log files.  
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Troubleshooting Secure Meeting 

If you encounter problems launching Secure Meeting, we recommend that you uninstall the Secure Meeting client from your system:  

1. In the Launch Application page, click the Troubleshooting link.  

2. Click Uninstall.  

3. Click Return to Meeting.  

4. Try to launch the meeting again.  

The next time you try to join a meeting, Secure Meeting updates your client with the latest version. 

If you continue to encounter problems, contact NetScreen Support. Send a clear description of the problem to NetScreen Support with 
detailed steps explaining how to reproduce the problem, the error message text, your IVE operating system and build number, and your IVE 
administrator log files, installation log files, and client-side log files.  

Accessing client-side log files 

Secure Meeting installs client files in different directories depending on your operating system and privileges. If you have:  

• Power user or administrative privileges on a Windows system  
Secure Meeting installs files in your C:\Program Files\Neoteris\Secure Meeting <version number>\dsCboxUI.log directory.  

• Regular user privileges on a Windows system  
Secure Meeting installs files in your C:\Documents and Settings\<user_name>\Local Settings\Temp\dsCboxUI.log directory or in 
C:\dsCboxUI.log. Note that if you cannot find your log files in the first directory, you may need to enable viewing of hidden files and 
folders. (In Windows Explorer, choose Folder Options from the Tools menu. Then, in the View tab, select Show hidden files and folders 
and click OK.)  

• Non-Windows system  
Secure Meeting writes to the java console. Copy/paste the contents of your java console into a separate file that you can send to 
NetScreen Support. 
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Accessing installation log files 

If you are running Secure Meeting in a Windows environment, check in the following directories for your installation log files: 

• C:\WINNT\Downloaded Program Files\NeoterisSetup.log  

• C:\NeoterisSetup.log  

If you are running in a non-Windows environment, Secure Meeting writes to the java console. Copy/paste the contents of your java console 
into a separate file that you can send to NetScreen Support. 

Accessing administrator log files 

Administrator log files are available from the System > Log/Monitoring page in the Administrator console. When retrieving logs, note that 
there are three: the events log, the user access log, and the administrator access log.  

Administrator console errors 

System > Status > Meetings page (Access Series) & System > Schedule page (Meeting Series) 
 

System >Status > Meetings errors (Monitoring Access Series appliance meetings) 
System > Schedule errors (Monitoring Meeting Series appliance meetings) 

Message:  Occurs when:  Solution:  

This will cancel the meeting and remove it from your view. Are you sure you 
wish to continue? 

message ID:  
I18N_MEETING_CONFIRM_CANCEL_MEETING 

The administrator or meeting creator 
chooses to delete a meeting from the 
Secure Meeting server.   

Administrator: Choose OK to delete 
the meeting, or choose cancel to 
keep the meeting.  

Note: You cannot recover a meeting 
after deleting it. You must 
reschedule a new meeting instead.  
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Resource Policies > Meetings page 
 

Resource Policies > Meetings page errors (Configuring resource policies) 

Message:  Occurs when:  Solution:  

You must specify a SMTP email server and an email address where bounced 
emails can be sent in order to enable the Secure Meeting email notification 
feature. 

message ID:  
I18N_MEETING_SMTP_CONFIG_MISSING 

The administrator enables the email 
server resource policy but does not 
enter a server or email address for 
the server.     

Administrator: Enter a SMTP server 
name or email address.  

SMTP server name unknown. 

message ID:  
I18N_MEETING_SERVER_NAME_UNKNOWN 

The administrator enables the email 
server resource policy but enters an 
invalid SMTP server name.  

Note: Secure Meeting may not 
necessarily detect an invalid server 
name at the time that it is entered.  

Administrator: Double-check the 
SMTP server name and re-enter.  

Please enter a SMTP login. 

message ID:  
I18N_MEETING_ERROR_SMTP_USER_MISSING 

The administrator enables the email 
server resource policy and then 
enters a password for the SMTP 
server, but no sign-in name. 

Administrator: Enter the sign-in 
name that corresponds to the 
password entered for the SMTP 
server. Or, if the SMTP server does 
not require a sign-in name and 
password, clear the password.  

Please enter a SMTP password. 

message ID:  
I18N_MEETING_ERROR_SMTP_PASSWORD_MISSING 

The administrator enables the email 
server and then enters a sign-in 
name for the SMTP server, but no 
password. 

Administrator: Enter the password 
that corresponds to the sign-in name 
entered for the SMTP server. Or, if 
the SMTP server does not require a 
sign-in name and password, clear 
the sign-in name. 

 



 

4.0 Secure Meeting Error Messages Document 

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
 
 

Page 5 of 32 

Users > Roles > Meetings page 
 

Users > Roles > Meetings page errors (Configuring user roles) 

Message:  Occurs when:  Solution:  

Important: The secure gateway begins enforcing your new security settings 
immediately. Since your new settings are stricter than previously specified, 
invitees may be barred from joining existing meetings that were created 
under the old settings. 

message ID:  
I18N_MEETING_GROUP_SETTINGS_WARNING 

The administrator changes the 
security settings (such as password 
requirements) requirements for the 
role. Changes may invalidate parts of 
existing meetings (such as the 
invitee list).  

Meeting Creator: Cancel changes. 
Or, save changes and notify 
members of the role that they should 
re-open their currently scheduled 
meetings to determine if all of their 
settings are still valid.  

 

User console errors  

Meetings page 
 
 

Meetings page errors (Viewing and deleting meetings) 

Message:  Occurs when:  Solution:  

This will cancel the meeting and remove it from your view. Are you sure you 
wish to continue? 

message ID:  
I18N_MEETING_CONFIRM_CANCEL_MEETING 

The administrator or meeting creator 
chooses to delete a meeting from the 
Secure Meeting server.   

Meeting Creator: Choose OK to 
delete the meeting, or choose cancel 
to keep the meeting.  

Note: You cannot recover a meeting 
after deleting it. You must 
reschedule a new meeting instead.  
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Meeting Details page 
 
 

Meeting Details page errors (Creating and modifying meetings) 

Message:  Occurs when:  Solution:  

The meeting name cannot exceed 100 characters. 

message ID: 
I18N_MEETING_NAME_EXCEEDS_LIMIT 

The meeting creator enters a 
meeting name longer than 100 
characters.   

Meeting creator: Shorten the 
meeting name.  

The meeting description cannot exceed 1000 characters. To find the 1000 
character limit in your current description, search for the following divider 
inserted by Secure Meeting: \"========The text beyond this point 
exceeds the 1000 character limit allowed for meeting 
descriptions.========\" 

message ID:  
I18N_MEETING_DESCRIPTION_EXCEEDS_LIMIT 

The meeting creator enters a 
meeting description longer than 
1000 characters.   

Meeting creator: Shorten the 
meeting description. To find the 
1000 character cut-off point, search 
for the divider inserted into the 
description.  

The meeting password is required. 

message ID:  
I18N_MEETING_ERROR_PASSWORD_REQUIRED 

The meeting creator tries to save a 
meeting without a password but the 
system administrator has specified 
that members of this role must 
password-protect their meetings.  

Meeting creator: Enter a password 
for the meeting. Or, ask your system 
administrator to change the 
requirement.  

Administrator: Change the 
password requirement in the Users > 
Roles > [Role] > Meetings page. 

Important: No password is specified for your meeting. Although a password 
is optional, it adds an extra level of security when dealing with users outside 
your network. 

message ID:| 
I18N_MEETING_PASSWORD_MISSING_WARNING 

The meeting creator deletes the 
automatic password generated by 
Secure Meeting and does not replace 
it with a new password.   

Meeting creator: Enter a meeting 
password, or ignore the message.  
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Meeting Details page errors (Creating and modifying meetings) 

Message:  Occurs when:  Solution:  

Important: Your meeting administrator has updated the security settings for 
your role. A password is now required in order to join meetings. Click “Save” 
to use the password generated for you by the system.  

message ID:  
I18N_MEETING_PASSWORD_REQUIRED_WARNING 

The meeting creator re-opens an 
existing meeting after the 
administrator has updated settings 
for the role from password-optional 
to password-required.  

Meeting creator: Click Save to 
accept the new system-generated 
password or create your own 
password and click Save. Then, 
notify the meeting invitees of the 
new password. Note that if email 
notifications are enabled on your 
server and your role is configured to 
send passwords in the emails, 
invitees with known addresses are 
automatically notified of the change.  

You have chosen to change the password of a meeting that is currently in-
progress. If you save your change, no action will be required of existing 
attendees. Any invitees that join after you make the change, however, must 
use the new password. Do you want to save changes? (To return to the 
Meeting Details page and revert to the previous password, click Cancel.) 

message ID:  
I18N_MEETING_PASSWORD_CHANGED_FOR_IN_PROGRESS_MEETING 

The meeting creator tries to update 
the password of a meeting that is in 
progress.  

Meeting creator: Click Save 
Changes and then notify any 
attendees who have not yet joined 
the meeting of the new password. 
Or, click Cancel to return to the 
Meeting Details page and revert to 
the old password. If you have made 
other changes, click Save Changes in 
the Meeting Details page to save all 
changes except the password.   

The meeting is in progress 

message ID: 
I18N_MEETING_WARN_MEETING_IN_PROGRESS 

The meeting creator tries to update 
the meeting ID, name, start time, or 
start date while the meeting is in 
progress. 

Meeting creator: Cancel saving 
changes.  Or, save the changes, but 
note that only the changes to the 
description, duration, and invitee list 
will be pushed down to the meeting 
client during the meeting. 
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Meeting Details page errors (Creating and modifying meetings) 

Message:  Occurs when:  Solution:  

You are only allowed to invite secure gateway users to the meeting. 

message ID: 
I18N_MEETING_ERROR_IVE_USERS_ONLY 

The meeting creator tries to add an 
out-of-network user to the invitee 
list, but the system administrator 
has specified that only secure 
gateway users may attend meetings 
scheduled by members of this role.   

Meeting creator: Do not invite the 
out-of-network user to the meeting. 
Or, contact your system 
administrator and ask him to allow 
out-of-network users to attend 
meetings. 

Administrator: Remove the 
restriction in the Users > Roles > 
[Role] > Meetings page of the 
administrator console. 

Your meeting administrator has updated the security settings for your role. 
Only secure gateway users are now allowed to attend the meeting. 

message ID: 
I18N_MEETING_IVE_REQUIRED_WARNING 

The meeting creator re-opens an 
existing meeting after the 
administrator has updated the 
settings for the role, changing the 
password requirement to in-network 
users only.  

Meeting creator: Click Save and 
then notify the meeting invitees that 
in-network users must sign in 
through their secure gateway 
sessions and out-of-network users 
can no longer attend.  

Secure Meeting cannot create the meeting because the specified start time 
has already past. To create a meeting that starts now, leave the Date and 
Start fields empty. (To clear the Date fields, you must use the drop-down 
lists.) 

message ID: 
I18N_MEETING_ERROR_CANNOT_CREATE_PAST_MEETING 

The meeting creator enters a 
meeting start time that has already 
past.  

Meeting creator: Clear all time and 
date fields to start the meeting now 
or enter a time in the future. Note 
that the time on your system clock 
may not match the time on the 
Secure Meeting server. In this case, 
you may want to enter a time a few 
minutes in the future to avoid any 
discrepancies.  

Cannot schedule a meeting after Dec 31, 2037 

message ID:  
I18N_MEETING_DATE_UPPER_LIMIT_WARNING 

The meeting creator enters a 
meeting date too far in the future.  

Meeting creator: Enter the current 
year or later (not to exceed 2037). 
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Meeting Details page errors (Creating and modifying meetings) 

Message:  Occurs when:  Solution:  

Cannot schedule a meeting before Jan 1, 1970 

message ID: 
I18N_MEETING_DATE_LOWER_LIMIT_WARNING 

The meeting creator enters a 
meeting date too far in the past. 

Meeting creator: Enter the current 
year or later (not to exceed 2037). 

The meeting duration has reached the limit allowed by your administrator for 
your role(s). 

message ID: 
I18N_MEETING_ERROR_MAX_DURATION_LIMIT_EXCEEDED 

A meeting creator tries to schedule a 
meeting for a longer duration than 
allowed by the system administrator.  

Meeting creator: Schedule the 
meeting for a shorter period of time. 
Or, contact your system 
administrator and ask him to extend 
the meeting limit. 

Administrator: Increase the limit in 
the Users > Roles > [Role] > 
Meetings page of the administrator 
console. 

Invalid meeting duration. 

message ID:  
I18N_MEETING_INVALID_DURATION 

The meeting creator enters zero in 
the Duration fields.   

Meeting creator: Enter a meeting 
duration that is longer than zero 
minutes.  

Email address invalid 

message ID: 
I18N_UIMSG_DS_INVALID_EMAIL 

The meeting creator enters an email 
address in the Invitees section that 
does not follow the format: X@Y.Z.  

Meeting creator: Re-enter the 
email address using the format: 
X@Y.Z. 

SMTP server name unknown. 

message ID:  
I18N_MEETING_SERVER_NAME_UNKNOWN 

The meeting creator enters an email 
address containing an invalid SMTP 
server name.  

Meeting creator: Re-enter the 
email address. 
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Meeting Details page errors (Creating and modifying meetings) 

Message:  Occurs when:  Solution:  

email missing 

message ID:  
I18N_MEETING_EMAIL_MISSING 

The meeting creator does not specify 
an email address for an invitee, 
saves the meeting, and re-opens it. 
The “email missing” message 
appears next to invitee’s name in the 
Invitee list.  

Meeting creator: Enter an email 
address for the invitee. Or, ignore 
the message and use a different 
method to notify the invitees of the 
meeting details.  

Important: Your system administrator has not enabled an email server that 
Secure Meeting can use to send email notifications. Please use another 
method to notify invitees of your meeting details, including the meeting 
name, purpose, when it will be held, and its venue (URL). 

message ID:  
I18N_MEETING_WARN_SMTP_SETTING_MISSING_USER_WARNING 

The meeting creator tries to create a 
meeting, but the administrator has 
not enabled a SMTP server.  

Meeting creator: Manually inform 
your meeting invitees of the meeting 
via email, telephone, or other 
method. Additionally, you may want 
to ask your system administrator to 
enable an email server. 

Please specify a conductor before saving the meeting. 

message ID: 
I18N_MEETING_PLEASE_SPECIFY_A_CONDUCTOR 

The meeting creator deletes the 
default conductor and does not 
specify a new one.  

Meeting creator: Select an in-
network user from your list of 
invitees and designate one as the 
conductor by clicking the Set as 
Conductor button.  

Conductor has to be an IVE user! 

message ID: 
I18N_MEETING_CONDUCTOR_HAS_TO_BE_IVE_USER 

 

The meeting creator designates an 
out-of-network invitee as the 
meeting conductor.  

Meeting creator: Select an in-
network user from your list of 
invitees and designate one as the 
conductor by clicking the Set as 
Conductor button. 
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Meeting Details page errors (Creating and modifying meetings) 

Message:  Occurs when:  Solution:  

The number of scheduled meetings has reached the limit allowed by your 
administrator for your role(s). 

message ID: 
I18N_MEETING_ERROR_MAX_SCHEDULED_MEETINGS_LIMIT_EXCEEDED 

A meeting creator tries to save a 
meeting but the number of meetings 
scheduled for the current time or 
beyond has exceeded the limit 
specified by the administrator or by 
the company’s license. 

Meeting creator: Wait until existing 
meetings have passed to schedule a 
new meeting. Or, contact your 
system administrator. 
 
Administrator: Extend the limit in 
the Users > Roles > [Role] > 
Meetings page or buy a more 
extensive Secure Meeting license 
from NetScreen. 

You are currently signed in to a different role than you were when you first 
created the meeting. If you choose to save changes, some of your meeting 
settings may be invalidated, depending on the resource limits and security 
restrictions set by your administrator for your various roles.  

message ID: 
I18N_MEETING_WARNING_GROUP_CHANGED 

The meeting creator tries to update a 
meeting that he created when he 
was signed into the secure gateway 
using a different role. This message 
is only displayed if the administrator 
does not choose to permissively 
merge roles.  

Meeting creator: Sign out of the 
existing role and then sign in to the 
role you were originally signed in to 
when you first created the meeting. 
Then, make your desired change. Or, 
save changes while you are signed in 
to your current role. However, if you 
choose the latter option, note that 
some of your original settings may 
no longer be valid (such as the 
meeting duration or the invitee list). 

Administrator: Permissively merge 
roles in the Users > Authentication > 
[Realm] > Role Mapping page of the 
administrator console.   

Error generating random string for the meeting ID. 

message ID:  
I18N_MEETING_ERROR_RANDOM_STRING 

The meeting creator saves a meeting 
and Secure Meeting encounters an 
error.  

Meeting creator: Contact your 
system administrator. 

Administrator: Contact NetScreen 
Support.  
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Meeting Details page errors (Creating and modifying meetings) 

Message:  Occurs when:  Solution:  

Unknown error. Please contact your system administrator.  

message ID: 
I18N_MEETING_ERROR_INTERNAL_ERROR 

Unknown.  Meeting creator: Contact your 
system administrator. 

Administrator: Contact NetScreen 
Support.  

 
 

Meeting site errors 

Sign-in page 
 

Sign-in page errors (Signing into a meeting using the https://<MeetingServer>/meeting URL) 

Message:  Occurs when:  Solution:  

The meeting ID that you have specified is invalid. 

Message ID:  
I18N_MEETING_ERROR_INVALID_MEETING_ID 

An invitee tries to join a meeting 
that has been deleted by the 
administrator or meeting creator. Or, 
the invitee incorrectly enters the 
meeting ID.  

Invitee: Re-check the meeting ID 
and then re-enter it.  If you still 
cannot join the meeting, contact the 
meeting creator and ask him if he 
plans to reschedule the meeting.  
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Sign-in page errors (Signing into a meeting using the https://<MeetingServer>/meeting URL) 

Message:  Occurs when:  Solution:  

Meeting ID not defined. 

Message ID:  
IDS_MSGBOX_MEETING_ID    

An invitee tries to join a meeting and 
a defect occurs when passing the 
meeting ID from the Secure Meeting 
server to the client.  

Invitee: Contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 

Please enter your name. 

Message ID: 
I18N_MEETING_PLEASE_SPECIFY_YOUR_NAME 

An invitee fails to enter his name.  Invitee: Enter your name into the 
name field.  

Username not defined. 

Message ID: 
IDS_MSGBOX_USER_NAME     

An invitee tries to join a meeting and 
a defect occurs passing the 
username from the server to the 
client. 

Invitee: Contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 

The meeting password is required. 

Message ID: 
I18N_MEETING_ERROR_PASSWORD_REQUIRED 

An invitee does not enter the 
password for a password-protected 
meeting.  

Invitee: Obtain the meeting 
password from your invitation email, 
the meeting creator, or another 
attendee. Or, sign in to the meeting 
through the Meetings page (in-
network invitees only).  

Invalid password. 

Message ID:  
I18N_MEETING_PASSWORD_INVALID 

An invitee enters the wrong meeting 
password.  

Invitee: Obtain the correct meeting 
password from your invitation email, 
the meeting creator, or another 
attendee. Or, sign in to the meeting 
through the Meetings page (in-
network users only). 
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Sign-in page errors (Signing into a meeting using the https://<MeetingServer>/meeting URL) 

Message:  Occurs when:  Solution:  

Meeting password has not been initialized. Please ask the meeting creator to 
add a password for this meeting and then try again. 

Message ID: 
I18N_MEETING_ERROR_PASSWORD_UNINITIALIZED 

An invitee tries to sign-in to a 
meeting that originally had a “secure 
gateway users” only requirement 
that was later changed to allow out-
of-network users to attend 
password-protected meetings. The 
meeting creator did not add a 
password to the meeting after his 
role’s requirements changed.  

Invitee: Ask the meeting creator to 
reopen the meeting, create a 
password, save the meeting, and 
distribute the password to the 
meeting invitees.  

 

Failed to join meeting. Please contact your system administrator. 

Message ID: 
IDS_MSGBOX_JOIN_FAILED   

An invitee tries to join a meeting and 
an unexpected error is sent from the 
Secure Meeting server to the client.   

Invitee: Contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 

You must sign in to the secure gateway home page before joining the 
meeting. 

Message ID: 
I18N_MEETING_REQUIRE_IVE_USER 

An out-of-network user tries to sign 
into a meeting that is restricted to 
in-network users.   

Invitee: If you are an in-network 
user, sign in to your secure gateway 
session and join using the Meetings 
page. Or, if you are an out-of-
network user, contact the meeting 
creator and tell him you are not 
allowed to attend the meeting.  
Meeting Creator: Contact your 
system administrator and ask him to 
remove the restriction on out-of-
network users.  
Administrator: Remove the 
restriction in the Users > Roles > 
[Role] > Meetings page of the 
administrator console. 
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Sign-in page errors (Signing into a meeting using the https://<MeetingServer>/meeting URL) 

Message:  Occurs when:  Solution:  

You cannot join this meeting because your secure gateway session has 
expired. Please sign back in to the secure gateway and then rejoin the 
meeting. 

Message ID: 
IDS_MSGBOX_IVE_LOGOUT 

An in-network user attempts to sign-
in to a meeting after his secure 
gateway session has expired.  

Invitee: Sign back in to your secure 
gateway session and then attempt to 
join the meeting again.  

The meeting that you are trying to join does not exist. 

Message ID: 
IDS_MSGBOX_EXISTS 

The meeting was cancelled between 
the times that the user tried to sign 
into and the meeting and the time 
that he launched the Secure Meeting 
application.  

Invitee: Refresh the Meetings page 
or your email and see if you have 
received an update telling you that 
the meeting is cancelled.  

The meeting that you are trying to join has been cancelled. 

Message ID: 
IDS_MSGBOX_CANCELED 

The meeting ended between the 
times that the user launched his 
browser and the time that he tried to 
sign into and the meeting. 

Invitee: No action required. You 
cannot join the meeting because it 
has ended.  

The maximum number of allowed meetings has been exceeded. 

Message ID: 
IDS_MSGBOX_MAX_MEETINGS_ALLOWED 

An invitee tries to sign into a 
meeting but the number of in-
progress meetings has exceeded the 
limit allowed by the Secure Meeting 
administrator.  

Invitee: Wait a few minutes for 
another meeting to end and then try 
signing in again. Or, contact your 
system administrator. 

Administrator: Increase the limit in 
the Users > Roles > [Role] > 
Meetings page of the administrator 
console.   
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Sign-in page errors (Signing into a meeting using the https://<MeetingServer>/meeting URL) 

Message:  Occurs when:  Solution:  

The maximum number of meeting licenses has been exceeded. 

Message ID: 
IDS_MSGBOX_MAX_MEETINGS_LICENSED 

An invitee tries to sign into a 
meeting but the number of in-
progress meetings has exceeded the 
limit allowed by the company’s 
Secure Meeting license. 

Invitee: Wait until existing meetings 
have passed and then sign in to your 
meeting. Or, contact your system 
administrator. 

Administrator: Purchase a more 
extensive license. 

The maximum number of allowed attendees has been exceeded. 

Message ID: 
IDS_MSGBOX_MAX_ATTENDEES_ALLOWED 

An invitee tries to sign in to a 
meeting but the number of 
simultaneous attendees has 
exceeded the limit specified the 
Secure Meeting administrator. 

Invitee: Wait until an existing user 
has left another meeting and then 
sign in to your meeting. Or, contact 
your system administrator. 

Administrator: Increase the limit in 
the Users > Roles > [Role] > 
Meetings page of the administrator 
console.   

The maximum number of licensed attendees has been exceeded. 

Message ID: 
IDS_MSGBOX_MAX_ATTENDEES_LICENSED 

An invitee tries to sign in to a 
meeting but the number of 
simultaneous attendees has 
exceeded the limit specified the 
company’s Secure Meeting license.  

Invitee: Wait until an existing user 
has left another meeting and then 
sign in to your meeting. Or, contact 
your system administrator. 

Administrator: Purchase a more 
extensive license. 
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Check Meeting Compatibility page 

Check Meeting Compatibility page (Determining client compatibility) 

Message:  Occurs when:  Solution:  

Your system is compatible with Secure Meeting. You may join the meeting. 

Message ID: 
I18N_MEETING_TEST_MSG_SYSTEM_COMPATIBLE 

The invitee’s computer is fully 
compatible with Secure Meeting.  

Invitee: Click the link to join the 
meeting.  

Your system is incompatible with Secure Meeting. 

Message ID: 
I18N_MEETING_TEST_MSG_SYSTEM_INCOMPATIBLE 

The invitee’s computer is not 
compatible with Secure Meeting. 

Invitee: Read the upgrade 
instructions that follow in order to 
determine what action is required.  

Your system is partially compatible with Secure Meeting. You can view the 
meeting, but cannot present. 

Message ID: 
I18N_MEETING_TEST_MSG_SYSTEM_PARTIAL_COMPATIBLE 

The invitee’s computer is partially 
compatible with Secure Meeting. 

Invitee: If you want to present 
during the meeting, read the 
remainder of the message for 
upgrade instructions. If you simply 
want to view the meeting, no action 
is required.  

You must enable Active-X components for full compatibility with Secure 
Meeting. To enable Active-X controls in Internet Explorer 6.0, choose Tools > 
Internet Options > Security > Custom Level, and then enable Active-X 
components through the Security Settings dialog box. 

Message ID: 
I18N_MEETING_TEST_MSG_WIN32_REQUIRE_ACTIVEX 

The invitee is using a Windows 
operating system, but does not have 
administrator or power user 
privileges on the system. (Or, the 
invitee has disabled Active X 
components through his Web 
browser.)  

Invitee: If you want to present 
during the meeting, enable Active-X 
components using the instructions in 
the message. Otherwise, attend the 
meeting as a viewer only.  
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Check Meeting Compatibility page (Determining client compatibility) 

Message:  Occurs when:  Solution:  

You must sign in from Internet Explorer 5.0 or above (with Active-X 
components enabled) for full compatibility with Secure Meeting. To download 
the latest version of Internet Explorer, click here. 

Message ID:  
I18N_MEETING_TEST_MSG_WIN32_REQUIRE_IE 

The invitee is using a Windows 
operating system and has enabled 
Java Virtual Machine (JVM) through 
his Web browser, but is not running 
Internet Explorer 5.0 or later.  

Invitee: If you want to present 
during the meeting, upgrade to 
Internet Explorer 5.0 or later using 
the linked Web site. Otherwise, 
attend the meeting as a viewer only. 

Or, you must install a Sun Java Virtual Machine (JVM) (version 1.4 or above) 
to view the meeting, but not present, or remote control. To download the 
latest supported version of the Sun JVM, click here.  

Message ID: 
I18N_MEETING_TEST_MSG_WIN32_REQUIRE_JAVA 

The invitee is has not enabled Java 
Virtual Machine (JVM) through his 
Web browser. 

Invitee: If you want to view the 
meeting, install the JVM using the 
linked Web site.  

You must sign in from a Windows system with Internet Explorer for full 
compatibility with Secure Meeting. 

Message ID: 
I18N_MEETING_TEST_MSG_NONWIN32_REQUIRE_WIN32 

The invitee is using a non-Windows 
operating system. 

Invitee: If you want to present 
during the meeting, sign into the 
meeting using a Windows system.  
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Launch Application and Troubleshooting pages 

Launch Application page and Troubleshooting page errors (Starting and removing the Secure Meeting client-side application) 

Message:  Occurs when:  Solution:  

You can only attend one meeting at a time. To join a new meeting, you must 
first exit your current meeting. 

Message ID: 
IDS_MSGBOX_ALREADY_RUNNING 

An invitee tries to join a meeting 
when he already has one running on 
his computer.  

Invitee: Exit the first meeting 
before trying to join another 
meeting.  

Secure Meeting is not supported with your platform. Currently, we support 
running Secure Meeting on: 

- Windows XP with Internet Explorer 6.0 SP1 or Netscape 7.1 
- Windows 2000 SP4 with Internet Explorer 6.0 SP1 or Netscape 7.1 
- Windows NT SP6 with Internet Explorer 6.0 SP1 
- RedHat 7.3 with Mozilla 1.5 and JVM 1.4.1 
- Mac 10.2.8 with Safari 1.1 and JVM 1.4.1 

Message ID: 
I18N_MEETING_PLATFORM_NOT_SUPPORTED 

An invitee tries to join a meeting 
using an incompatible operating 
system or browser.  

Invitee: Sign in to the meeting 
using one of the listed supported 
platforms.  

The Secure Meeting client version that is installed on your computer is no 
longer supported. 

Message ID: 
IDS_MSGBOX_UNSUPPORT 

The Secure Meeting client on the 
invitee’s machine is older than the 
Secure Meeting server to which he is 
connecting and the server cannot 
automatically update the client.  

Invitee: Click the Troubleshooting 
link on the Launch Application page 
and Uninstall your client. Then, try 
joining the meeting again.  
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Launch Application page and Troubleshooting page errors (Starting and removing the Secure Meeting client-side application) 

Message:  Occurs when:  Solution:  

JavaScript is disbaled on this machine. You need to enable it before system 
checks can be performed. 

Message ID: 
I18N_MEETING_JS_DISABLED_TEXT 

An invitee tries to join a meeting 
using a browser that does not have 
JavaScript enabled.  

Invitee: Enable JavaScript: To 
enable java script in:  

- Internet Explorer 6.0: Navigate to 
Tools > Internet Options > Security 
tab, and choose Custom Level. Under 
Scripting of Java applets, choose 
Enable.  

- In Netscape Navigator 7.1, 
navigate to Edit > Preferences. 
Under Advanced > Scripts & Plugins, 
select the Navigator check box. 

 

Secure Meeting does not support monitor resolutions greater than 2048 by 
2048 pixels. 

Message ID: 
IDS_MSGBOX_RESOLUTION_UNSUPPORT 

An invitee tries to join a meeting 
using an unsupported monitor 
resolution in a dual-monitor setup.  

Invitee: Reduce your monitor 
resolution to 2048 x 2048 or less. 
Or, join using a different computer.  

You cannot join this meeting because you have not accepted the security 
certificate that is required in order to connect to the Secure Meeting server. 

Message ID: 
IDS_MSGBOX_INVALID_CERT 

The system administrator has not 
installed a valid certificate on the 
Secure Meeting server and the user 
does not accept the temporary 
certificate when prompted. This 
message appears most often to 
users connecting to an evaluation 
version of Secure Meeting.   

Invitee: Sign in again and accept 
the invalid certificate. In rare cases, 
you may need to actually install the 
certificate.  
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Launch Application page and Troubleshooting page errors (Starting and removing the Secure Meeting client-side application) 

Message:  Occurs when:  Solution:  

Problems with this Web page might prevent it from being displayed properly 
or functioning properly. In the future, you can display this message by 
double-clicking the warning icon displayed in the status bar.  

Internet Explorer has not yet fully 
downloaded the Secure Meeting 
Active-X to the user’s system.  

Invitee: Wait for the Active-X 
component to finish downloading. 
Check the browser’s status bar for 
progress.  

The meeting that you are trying to join has not yet started. It is too early to 
join. 

Message ID: 
IDS_MSGBOX_EARLY 

An invitee tries to join the meeting 
more than 15 minutes before it is 
scheduled to begin.  

Invitee: Double-check when the 
meeting is supposed to be held and 
then join up to 15 minutes before 
that time. If there seems to be a 
discrepancy, note the time zone 
listed in the invitation since it may 
be different from yours. 

The meeting that you are trying to join has already past. 

Message ID: 
IDS_MSGBOX_PAST 

An invitee tries to join a meeting 
that has already ended.  

Invitee: Double-check when the 
meeting is supposed to be held. If 
there seems to be a discrepancy, 
note the time zone listed in the 
invitation since it may be different 
from yours. 

Cannot connect to the Secure Meeting server. We suggest checking your 
network connection. If the problem still persists, contact your system 
administrator. 

Message ID: 
IDS_MSGBOX_SESSION_EXPIRED 

An invitee tries to launch the 
meeting application and join a 
meeting, but the Secure Meeting 
client application cannot contact the 
Secure Meeting server.  

Invitee: Check your network 
connection.   

Administrator:  If the user 
continues to have problems 
connecting to the server, contact 
NetScreen Support.   
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Launch Application page and Troubleshooting page errors (Starting and removing the Secure Meeting client-side application) 

Message:  Occurs when:  Solution:  

Failed to connect to the Meeting server. Please contact your system 
administrator. Error code: 

Message ID: 
IDS_MSGBOX_DEFAULT 

The user’s client is connected to the 
Secure Meeting, but then receives an 
error back from the server that it 
cannot handle.  

Invitee: Contact your system 
administrator.  

Administrator: Contact NetScreen 
Support.  

Secure Meeting encountered an error during installation. To successfully 
install the Secure Meeting application, you must restart your computer and 
then launch the Secure Meeting application again. We recommend that you 
save changes and then close any open applications, however, before 
restarting. Do you want to restart your computer now? 

The Secure Meeting installer 
encounters an error while installing a 
new or upgraded version of the 
Secure Meeting client on the user’s 
machine.   

Invitee: Click Yes to restart your 
system immediately and begin using 
Secure Meeting. Or click No to wait. 
You may wish to click No if you need 
to save data in open applications 
before restarting.   

The application that is currently installed on your machine is corrupt. Do you 
want to download a new version? 

Message ID: 
IDS_ERR_CORRUPTED            

Secure Meeting detects a corrupt 
version of the software on your 
system.  

Invitee: Install a new version of 
Secure Meeting on your machine. If 
the problem persists, contact your 
system administrator.  

Administrator: Contact NetScreen 
Support. 

A network connection error occurred during download. 

Message ID: 
IDS_ERR_CONNECTION       

Secure Meeting encounters an 
unexpected network connection error 
downloading the Secure Meeting 
Active-X component to the client 
after the user has launched the 
Secure Meeting application.   

Invitee: Contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 
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Launch Application page and Troubleshooting page errors (Starting and removing the Secure Meeting client-side application) 

Message:  Occurs when:  Solution:  

Failed to download the application. Please sign in and try again. If the 
problem continues, please contact your system administrator. 

Message ID: 
IDS_ERR_DOWNLOAD             

Secure Meeting installs a different 
product version on the user’s 
machine and an unexpected error 
occurs during the 
upgrade/downgrade process. The 
error may occur due to a secure 
gateway session timeout.  

Invitee: Try launching the 
application again. If the problem 
persists, contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 

 

Failed to verify the downloaded application. Application cannot start. 

Message ID: 
IDS_ERR_VERIFY               

Occurs when downloading the Secure 
Meeting client and an unexpected, 
non-HTTPS error occurs. The error 
may occur due to trouble verifying 
the code-signing certificate.  

Invitee: Try launching the 
application again. If the problem 
persists, contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 

Failed to start the downloaded application. Please sign in and try again. If 
the problem continues, please contact your system administrator. 

Message ID: 
IDS_ERR_RUN_DOWNLOAD         

Occurs if the application cannot run. 
The error may occur if the user 
doesn’t use the proper method of 
uninstalling product files (i.e., he 
deletes them from his file directory, 
but they are still in the system 
registry). The error may also occur if 
the application became corrupt 
during download.   

Invitee: Try launching the 
application again. If the problem 
persists, contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 
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Launch Application page and Troubleshooting page errors (Starting and removing the Secure Meeting client-side application) 

Message:  Occurs when:  Solution:  

Secure Meeting encountered an error during the uninstall process. To 
successfully uninstall the Secure Meeting application, you must restart your 
computer and then try to uninstall the application again. We recommend that 
you save changes and then close any open applications, however, before 
restarting. Do you want to restart your computer now? 

The Secure Meeting installer 
encounters an error while 
uninstalling a Secure Meeting client 
on the user’s machine. (Secure 
Meeting may uninstall the client at 
user’s request or automatically 
during an upgrade process.)    

Invitee: Click Yes to restart your 
system immediately and begin using 
Secure Meeting. Or click No to wait. 
You may wish to click No if you need 
to save data in open applications 
before restarting.   

 

Failed to uninstall. Please restart your computer and try again. 

Message ID: 
IDS_ERR_UNINSTALL            

The Secure Meeting installer 
encounters an error while 
uninstalling a Secure Meeting client 
on the user’s machine. (Secure 
Meeting may uninstall the client at 
user’s request or automatically 
during an upgrade process.)    

Invitee: Restart your computer and 
try again. If you continue to have 
problems, contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 

You do not have the proper privileges to uninstall the application. 

Message ID: 
IDS_ERR_NO_UNINSTALL_PRIVILEGES 

A user with administrative or power 
user privileges ran Secure Meeting 
on the user’s machine. Then, a user 
without these privileges signed into 
the same machine and tried to 
uninstall the Secure Meeting client 
application.  

Invitee: Sign into your computer 
using an account with administrative 
or power user privileges and then try 
uninstalling the application again.  

You cannot uninstall the application, because it is not currently installed on 
your computer. 

Message ID: 
IDS_ERR_NOT_INSTALLED        

The end-user clicks the Uninstall 
button, but the client is not installed 
on his machine. 

Invitee: No user action required. If 
the desired result is to uninstall the 
application, then the action is 
already done.   
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Secure Meeting window 

Secure Meeting window errors (Using the Secure Meeting client-side application) 

Message:  Occurs when:  Solution:  

You cannot join this meeting because your secure gateway session has 
expired. Please sign back in to the secure gateway and then rejoin the 
meeting. 

Message ID: 
IDS_MSGBOX_IVE_LOGOUT 

An in-network user signs out of his 
secure gateway session before 
signing out of a meeting.  

Attendee: Sign back in to your 
secure gateway session and then 
sign back in to the meeting.  

The connection to the Meeting Server has been lost. Possible reasons include 
the server or network connection is down. Please contact your system 
administrator. 

 

Message ID: 
IDS_MSGBOX_DISCONNECTED 

An unexpected NetScreen 
Communication Protocol (NCP) error 
occurs during the meeting. 

Attendee: Wait for the client to 
reestablish a connection the Secure 
Meeting server. If the problem 
persists, contact your system 
administrator. 

Administrator: Contact NetScreen 
Support.   

Attempting to connect to Secure Meeting server … [Cancel Meeting] 

Message ID: 
IDD_CONNECTING 

The user’s client becomes 
disconnected from the Secure 
Meeting server and tries to 
reestablish the connection.  

Attendee: Click Cancel Meeting to 
disconnect from the meeting. Or, if 
you do not wish to disconnect, wait 
for your system to reestablish a 
connection to the Secure Meeting 
server.  If the problem persists, 
contact your system administrator.  
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Secure Meeting window errors (Using the Secure Meeting client-side application) 

Message:  Occurs when:  Solution:  

Your connection to the Secure Meeting server has been lost. To continue 
trying to reconnect, click Retry. Or, click Cancel to exit. 

Message ID: 
IDS_MSGBOX_RECONNECT 

The client fails to reconnect to the 
Secure Meeting server.  

Attendee: Click Cancel to 
disconnect from the meeting. Or, if 
you do not wish to disconnect, click 
Retry to prompt your system to 
reestablish a connection to the 
Secure Meeting server.  If the 
problem persists, contact your 
system administrator. 

The meeting has been disconnected. 

Message ID: 
IDS_MSGBOX_MEETING_DISCONNECTED 

The protocol that is used to pass 
messages from the client to the 
server (NCP) tells the client that it is 
disconnected, but the Secure 
Meeting server is not seeing 
anything abnormal. 

Attendee: Wait for the client to 
automatically reconnect to the 
Secure Meeting server. If the 
problem persists, contact your 
system administrator.  

Administrator: Contact NetScreen 
Support.  

The meeting conductor has ended the meeting. 

Message ID: 
IDS_MSGBOX_ MEETING_CLOSE_BY_CONDUCTOR 

The meeting ends because the 
conductor exits the meeting.   

Attendee: If you feel that the 
meeting was ended prematurely, ask 
the meeting conductor to schedule 
another meeting.   

The meeting has ended because the conductor has been gone for 15 
minutes. 

Message ID: 
IDS_MSGBOX_MEETING_CLOSE_BY_CONDUCTOR_DISCONNECT 

The meeting ends because the 
conductor is absent for 15 minutes.  

Attendee: If you feel that the 
meeting was ended prematurely, ask 
the meeting conductor to schedule 
another meeting.   
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Secure Meeting window errors (Using the Secure Meeting client-side application) 

Message:  Occurs when:  Solution:  

The meeting has ended because it exceeded the scheduled duration 

Message ID: 
IDS_MSGBOX_MEETING_CLOSE_BY_SERVER_TIME_OUT 

The meeting ends because the 
meeting’s scheduled duration has 
been reached.   

Attendee: If you feel that the 
meeting was ended prematurely, ask 
the meeting conductor to schedule 
another meeting.   

The Secure Meeting administrator has ended the meeting. 

Message ID: 
IDS_MSGBOX_ MEETING_CLOSE_BY_ADMINISTRATOR 

The meeting ends because the 
meeting administrator deletes the 
meeting. 

Attendee: If you feel that the 
meeting should not have been 
cancelled, ask the meeting conductor 
to schedule another meeting.   

Conductor: Schedule a new meeting 
through the Meetings page.  

The meeting creator has ended the meeting. 

Message ID: 
IDS_MSGBOX_ MEETING_CLOSE_BY_CREATOR 

The meeting ends because the 
meeting creator deletes the meeting. 

Attendee: If you feel that the 
meeting should not have been 
cancelled, ask the meeting creator to 
schedule another meeting.   

Meeting Creator: Schedule a new 
meeting through the Meetings page. 

You have been removed from the meeting. 

Message ID: 
IDS_MSGBOX_MEETING_USER_REMOVED 

The conductor or creator removes 
the attendee from the meeting 
(either through the Meeting Details 
page in the end-user’s console or 
through the Secure Meeting window 
itself).  

Attendee: Rejoin the meeting.  
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Secure Meeting window errors (Using the Secure Meeting client-side application) 

Message:  Occurs when:  Solution:  

Failed to extend the meeting. The maximum allowed meeting duration has 
been exceeded. 

Message ID: 
IDS_MSGBOX_EXTEND_FAILED_MAX_ALLOWED 

The conductor tries to extend the 
meeting beyond the limit specified 
by the administrator.  

Attendee: Ask your system 
administrator to extend the meeting 
limit.  

Administrator: Extend the limit in 
the Users > Roles > [Role] > 
Meetings page of the administrator 
console.  

Failed to extend the meeting. 

Message ID: 
IDS_MSGBOX_EXTEND_FAILED 

The conductor tries to extend the 
meeting and Secure Meeting 
encounters an unknown error trying 
to grant the request.  

Administrator: Contact NetScreen 
Support. 

Failed to change roles. 

Message ID: 
IDS_MSGBOX_ROLE_CHANGE_FAILED 

The conductor or presenter tries to 
assign different roles to any attendee 
and an unknown error occurs.  

Attendee: Contact your system 
administrator. 
Administrator: Contact NetScreen 
Support.  

You cannot make the specified meeting attendee a conductor. Only secure 
gateway attendees may conduct meetings. 

Message ID: 
IDS_MSGBOX_IVE_REQUIRED 

The conductor tries to pass 
conductor rights to an out-of-
network attendee.  

Attendee: Pass conductor rights to 
an in-network attendee.  

This attendee is using a java-client and cannot be made presenter. 

Message ID: 
IDS_MSGBOX_PRESENTER_NOT_ALLOWED 

The conductor tries to pass presenter 
rights to an attendee with limited 
privileges.  

Conductor: Pass presenter rights to 
another attendee. Or, if you want 
this attendee to present, ask him to 
run the Compatibility Checker 
(available from the meeting sign-in 
page) to determine what he needs to 
upgrade in order to present.  
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Secure Meeting window errors (Using the Secure Meeting client-side application) 

Message:  Occurs when:  Solution:  

You cannot pass control of your shared application(s) to another meeting 
attendee. The Secure Meeting administrator has disabled remote control for 
the meeting. 

Message ID: 
IDS_MSGBOX_REMOTE_CONTROL_DISABLED 

The presenter tries to assign remote 
control rights to another attendee, 
but the administrator has disabled 
this feature. 

 

Attendee: Ask your system 
administrator to enable remote 
control capabilities for your role. 

Administrator: Remove the 
restriction from the Users > Roles > 
[Role] > Meetings page of the 
administrator console.  

Failed to remove attendee from the meeting. 

Message ID: 
IDS_MSGBOX_REMOVE_USER_FAILED 

The conductor tries to remove an 
attendee and an unexpected error 
occurs.  

Attendee: Contact your system 
administrator.  

Administrator: Contact NetScreen 
Support.  

Please select the application that you want to share.  

Message ID: 
IDS_MSGBOX_SELECT 

The presenter clicks Share in the 
Share Application dialog box, but 
does not select any applications to 
share with other attendees.  

Presenter: Select the checkboxes 
next to the application(s) that you 
want to share and then click Share.  

Failed to share desktop. Please contact your system administrator. 

Message ID: 
IDS_MSGBOX_DESKTOP_SHARING_FAILED 

The presenter tries to share his 
desktop and the Secure Meeting 
server sends an unexpected error to 
the client.   

Attendee: Contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 

Failed to share application(s). Please contact your system administrator. 

Message ID: 
IDS_MSGBOX_APP_SHARING_FAILED 

A presenter tries to share his 
desktop or selected applications and 
the Secure Meeting server sends an 
unexpected error to the client.  

Attendee: Contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 
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Miscellaneous 

Miscellaneous errors  

Message:  Occurs when:  Solution:  

The Secure Meeting application must be started through a web browser. 

Message ID: 
IDS_MSGBOX_USE_BROWSER 

A user tries to launch dsCboxUI.exe 
from Windows Explorer or another 
file browsing system when he has 
not yet started a meeting.  

Attendee: Launch Secure Meeting 
through a Web browser.   

You must start this ActiveX control from a Web browser. 

Message ID: 
IDS_MSGBOX_USE_BROWSER 

The Secure Meeting client cannot 
access the Active-X component’s 
cookie and URL. This can occur 
whenever the Active-X is accessed 
using an unauthorized method. 

Attendee: Start the Secure Meeting 
application using the standard 
methods (i.e., join a meeting). If you 
continue to have problems, contact 
your system administrator.  

Administrator: Contact NetScreen 
Support. 

Failed to create a temporary file and write to the local machine. 

Message ID: 
IDS_ERR_WRITE            

There is not enough disk space on 
the client computer for the Secure 
Meeting to read and write files. Or, 
the user does not have Write 
privileges to the proper directories 
on his computer.  

Attendee: Free up disk space on 
your local hard drive. If the problem 
persists, contact your system 
administrator.  

Administrator: Contact NetScreen 
Support.  

An unexpected error occurred. 

Message ID: 
IDS_ERR_UNEXPECTED       

Undefined. Attendee: Contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 
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Miscellaneous errors  

Message:  Occurs when:  Solution:  

System Error. Please sign in and try again. If the problem continues, please 
contact your system administrator. 

Message ID: 
IDS_ERR_SYSTEM_ERR           

Secure Meeting cannot download the 
URL, create a thread, create a 
memory mapped file, or otherwise 
execute the application.  

Attendee: Contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 

The specified URL is invalid. The application download cannot be found. 

Message ID: 
IDS_ERR_URL              

Secure Meeting encounters an 
unexpected error referencing the 
meeting URL.  

Attendee: Contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 

Failed to query the content. 

Message ID: 
IDS_ERR_CONTENT          

Secure Meeting encounters an 
unexpected error when trying to 
read content from the application.  

Attendee: Contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 

Failed to read from URL. 

Message ID: 
IDS_ERR_READ             

Secure Meeting encounters an 
unexpected error while querying the 
URL content on the server during a 
meeting. 

Attendee: Contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 

The maximum number of allowed file browsing sessions has been exceeded. 

Message ID: 
I18N_FILE_BROWSING_OVER_QUOTA 

A Meeting Series appliance user tries 
to browse the company’s file 
directory through his secure gateway 
homepage, but the number of 
browsing sessions has exceeded the 
limit specified by the company’s 
license. 

User: Wait until an existing user has 
finished browsing and then try again. 
Or, contact your system 
administrator. 

Administrator: Purchase a more 
extensive license from NetScreen.    
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Miscellaneous errors  

Message:  Occurs when:  Solution:  

The maximum number of allowed web browsing sessions has been exceeded. 

Message ID: 
I18N_REWRITING_OVER_QUOTA 

A Meeting Series appliance user tries 
to browse the web through his 
secure gateway homepage, but the 
number of browsing sessions has 
exceeded the limit specified by the 
company’s license. 

User: Wait until an existing user has 
finished browsing and then try again. 
Or, contact your system 
administrator. 

Administrator: Purchase a more 
extensive license from NetScreen.    

Server SSL certificate MD5 sum is not defined. 

Message ID: 
IDS_MSGBOX_CERT_MD5  

Secure Meeting encounters an 
unexpected Web page error.  

Attendee: Contact your system 
administrator.  

Administrator: Contact NetScreen 
Support. 

 


